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A. Accessing the VLE 

The VLE is available at, 

• UM VLE: https://www.um.edu.mt/vle/my  

• JC VLE: https://www.um.edu.mt/jc/vle/my   
 

or by selecting VLE from the Current students drop-down menu at the upper left-hand corner of the 
University of Malta homepage. 

 

If you are already signed in, you will immediately be 
directed to the VLE. Your VLE Dashboard will be 
displayed, showing all the areas that you have access to. 

If you are not signed in, the UM IT Account 
authentication screen is displayed. Type in your Email 
address or Username and Password in the respective 
fields, and click the Sign in button. 

 
 
 
 
 
 
 
 

 
Note that: 

▪ Before entering your UM IT username and password in any screen, you should routinely check 
that the web address of the page displayed in the browser begins with 
https://accounts.um.edu.mt/ 

https://www.um.edu.mt/vle/my
https://www.um.edu.mt/jc/vle/my
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▪ When you sign in, your name and surname will be displayed at the top-right of the screen. 

 

▪ It is of utmost importance that you sign out and close all browser windows when you are done 
using UM services, particularly if you are using a shared computer which is not set up with 
different computer accounts for different users. If you don't sign out or lock your user account 
on that computer, subsequent users of the computer will have total access to the UM services 
that you have permission to use. The safest way to ensure that you have signed out from all UM 
services is by closing all the browser windows. 

 

B. Accessing VLE areas 

When you access the VLE, your VLE areas will be displayed in the My VLE areas block. By default, My 
VLE areas displays all the VLE areas you are registered for by listing the latest academic year/s at the 
top, then the PG Dissertations (if you are a UM postgraduate student), and finally the archived academic 
years. 

 

If you cannot find a particular VLE area in the list, make sure that your tutor is using the VLE. Not all 
tutors will make use of the VLE. Your tutors should inform you if they are expecting you to use the VLE 
for their study-unit / class areas. 
 
If your tutor is using the VLE but you cannot find the study-unit / class area, there could be two possible 
reasons: 

1. You are not registered for your study-unit / class on eSIMS / eSIMS JC. Refer to VLE FAQ 4 for 
more information. 

2. Your tutor/s have not made the VLE area available to students. It is best to inform your tutor/s 
that you cannot access the VLE area so that they make it available to students. Your tutors can 
contact us if they require assistance. 

https://www.um.edu.mt/itservices/vle/info/faqs/#d.en.61027


 Getting started with the VLE - Student guide v6.0 

 ‘Getting started with the VLE - Student guide‘ is licensed under the Creative Commons 
Attribution-NonCommercial-ShareAlike 4.0 International License. To view a copy of this license, visit 
http://goo.gl/R8rwUW. 

IT Services, University of Malta 
www.um.edu.mt/itservices 

3 

 

C. Overview of the VLE area 

By default, the homepage of each VLE area has the layout shown below:  

 

 

 

This is the Course index drawer, which acts as a table of contents for activities and resources 
available within a VLE area. Students can click on an activity and navigate directly to it. For more 
screen space, this drawer can be opened and closed as required. 

A tabular navigation menu at the top of each VLE area. 

This is the main content area where tutors upload study material and set up activities. This 
area is typically divided into sections: Topics or Weeks. Each topic or week may contain 
subsections, lecture notes, links to readings, forums, quizzes, assignments, etc. 

By default, the first section is often referred to as the General section. This contains the 
Announcements forum (used for class announcements) and may also contain other 
introductory study-unit / subject level information such as a link to the study-unit / syllabus 
description. 

 

2 

1 

3 

1 2 

3 4 
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On the right-hand side of your screen, you will find the following blocks: 

▪ Latest announcements – lists the latest items added to the Announcements forum. 

▪ Recent activity – shows recent changes to the VLE area since the user’s last login, such as, 
creation of new resources and activities, forum postings and your assignment submissions. 

▪ My VLE areas – enables easier access between VLE areas. 

▪ Activities – lists the variety of activities created in the VLE area. For example, if you would 
like to view all the forums in an area, click on the Forums link. 

▪ Calendar – displays a small version of the current month’s calendar. Events and due dates 
are colour-coded to distinguish VLE area events from personal (User) events. 

▪ Lecture Capture (Panopto) – lists Panopto captured videos and/or other uploaded media 
files, if any. 

 

  

4 
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D. Editing your Profile  

You are encouraged to set your profile as soon as you start using the 
VLE. You may upload a picture of yourself and type some information 
such as a short description of yourself, course interests, etc. 

To edit your profile: 

1. Click on your User menu (upper right corner).  

2. Click Profile. 

3. Click the Edit profile link within the User details section. 

4. Set your City/town. 

5. Select your country from Select a country. 

6. In the Description field type some descriptive information. 

 

7. Click the Update profile button. 

Note: 

• If there are typo errors in your name and surname, please contact your Faculty or 
Departmental Office to have these corrected. 

• Some fields have a Help button . Click this button to view context sensitive help. 



 Getting started with the VLE - Student guide v6.0 

 ‘Getting started with the VLE - Student guide‘ is licensed under the Creative Commons 
Attribution-NonCommercial-ShareAlike 4.0 International License. To view a copy of this license, visit 
http://goo.gl/R8rwUW. 

IT Services, University of Malta 
www.um.edu.mt/itservices 

6 

 

By default, a profile’s display picture is a white silhouette on a grey background. To 
upload your picture: 

1. Click on your User menu (upper right corner). 

2. Click Profile. 

3. Click the Edit profile link within the User details section. 

4. Scroll down to the User picture section. 

5. Drag a picture of yourself from your computer to the designated ‘drag-and-drop’ upload area. 

 

Alternatively, click the Add…  button. This will display the File picker dialog box. 

 

a. Select Upload a file from the menu on the left-hand side. 
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b. Click the Choose file button. 

c. Browse to the location where your picture file is stored. 

d. Double-click the picture file to upload. 

e. Click the Upload this file button. 

f. Type a description in the Picture description field for the benefit of visually impaired 
users who make use of a screen reader. You can type your name and surname. 

6. Click the Update profile button. 

 
To delete your profile picture: 

1. Click on your User menu (upper right corner).  

2. Click Profile. 

3. Click the Edit profile link within the User details section. 

4. Scroll down to the User picture section, and tick the Delete picture checkbox below your picture. 

5. Click the Update profile button. 

 

  

Note: 

• Use a JPG or PNG file format for your picture. The VLE will crop your picture and shrink it to 
100 by 100 pixels. 

• Once uploaded, your picture will appear in your profile, in the Participants page and next to 
all your forum postings. The same picture will appear for all your VLE areas in the VLE. 
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E. Viewing the Participants list of a VLE area 

To view the tutor/s and any other students enrolled in a VLE area: 

1. Click Participants from the tabular menu at the top of the page. 

 

This will display the participants enrolled on the VLE area (shown below). If the participants 
enrolled on the VLE area amount to more than 20, they will be listed in sets of 20 participants 
per page. You can click the Show all xx link available at the bottom of the page. 

 

2. Within the Match setting, leave the first drop-down menu as Any. 

3. From the Select drop-down menu, choose Roles. A third drop-down menu is displayed. 

➢ Select Student from the drop-down menu to view a list of students. 

➢ Select Tutor from the drop-down menu to view a list of tutor/s. 

4. Click the Apply filters button. 

5. Click the Clear filters button to remove any applied filters and view all participants again. 

6. Return to the VLE area homepage by clicking the Study-unit / Class tab in the navigation menu. 
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F. VLE area resources and activities 

As outlined in section C, the middle section of the VLE area homepage is where your tutor will put the 
main study material and activities. Different resources and activities may be identified by their unique 
icon. 
 
Resources 

 
 
Activities 
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Submitting assignments 
Your tutor may require you to submit your assignments (such as essays, spreadsheets, presentations, 
web pages, photographs, video / audio-clips) for grading through the VLE.  

There are three types of assignment activities which your tutor might make available in a VLE area: 

 

Assignment – used to collect students work. Refer to the guidelines below if you need to 
submit via an Assignment activity. 

 

Assignment (Turnitin) – used to detect and prevent possible plagiarism in students’ 
uploaded assignments (available in UM VLE only). Guidelines are available in the Submitting 

through Turnitin user guide. 

 

Assignment (with Panopto) – used to upload media files such as videos or audio podcasts. 
Guidelines are available in the Submitting via an Assignment (with Panopto) activity 
guide. 

 

To submit to an Assignment activity: 

1. Click the assignment title in the home page of the VLE area. You will be directed to the 
submission area. 

 

Information such as the assignment question and due date will be displayed. 

 

2. Click the Add submission button.  
 

Information about plagiarism detection and the use of Turnitin is available. 

https://www.um.edu.mt/media/um/intranetstaffumstudents/itservices/turnitin/turnitinupld-std.pdf
https://www.um.edu.mt/media/um/intranetstaffumstudents/itservices/turnitin/turnitinupld-std.pdf
https://www.um.edu.mt/media/um/docs/directorates/itservices/panopto/SubmittingviaanAssignment(withPanopto).pdf
https://www.um.edu.mt/itservices/vle/turnitin/
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The File submissions tool will be displayed. 

 

3. Drag your assignment file from your computer to the designated ‘drag-and-drop’ upload area, 
and proceed to step 9. 

Alternatively, click Add…  button. This will display the File picker dialog box. 

 

4. Click the Choose file button. 

5. Browse to the location where your assignment file is stored. 

6. Double-click the file to upload. 

7. Click the Upload this file button. 

8. Click the Save changes button. 
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G. Participating in forum discussions 

You can access a forum from the link within the contents section of the VLE area. Forums are 
denoted by the icon displayed on the right. 

A list of all the forums in the VLE area (underlying image) can also be accessed by clicking the Forums 
link in the Activities block (typically located on right side of the VLE area homepage). 

 

The Forums page displays information about each forum, including title, description and number of 
discussions, as well as, whether you are subscribed to a forum or not. 
 
 
Reading forum discussions 

To read a forum discussion: 

1. Access the required forum. 

A listing of the forum’s discussion topics (also known as threads) is displayed. For each topic, 
information is displayed, such as the participant who started the topic and the number of replies. 

2. To view a topic, click its title under Discussion. You will now see all the postings made in that 
discussion topic. 
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3. A discussion topic may be displayed in four different ways. 
Click the drop-down menu at the top of the discussion 
thread to select a display type. By default, a thread 
displays replies in nested form. 

▪ Display replies flat, with oldest first – The replies 
are displayed aligned and in chronological order, 
from the oldest reply to the newest one. 

▪ Display replies flat, with newest first - The replies are displayed aligned and in 
chronological order, from the newest reply to the oldest one. 

▪ Display replies in threaded form - Only the initial post is displayed entirely. Replies are 
reduced to the headlines (including author and date of posting) and shifted to the right. 
Any replies to the same post are aligned. 

▪ Display replies in nested form - All posts are displayed in their entirety. Replies are 
shifted to the right so that only replies to the same are aligned. 
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Posting & replying 

Posting or replying to a message is similar to composing an email. You can 
start a new topic by clicking the Add discussion topic button (if available) 
on the forum’s main page. 

In most cases you will be replying to an existing post. 

1. Click the Reply link (allocated at the bottom right of each post) to reply to a message.  

2. Type in the content of your reply in the Write your reply… text box. 

3. Optionally, you may attach a file (e.g. MS Word document, PDF, etc.) to your reply by dragging 
it from your computer to the designated ‘drag-and-drop’ upload area. Note that to attach a file 
you must first click the Advanced link. 

 

4. Click the Post to forum button. 

After posting your message, you are given a 30-minute time window to edit or delete your post. This is 
very helpful if you hit the Post to forum button too soon or spot a mistake after posting. Links to Edit or 
Delete your post are available at the bottom of your submitted post for the 30-minute period. 
 

 

  

Note:  

• When you copy text from MS Word and paste this to the text editor, you might need to use 

the Clear formatting  tool (available via the Format menu) to remove unnecessary HTML 
tags. 

 
Note:  

• When you copy text from MS Word and paste this to the text editor, you might need to use 

the Clear formatting  tool (available via the Format menu) to remove unnecessary HTML 
tags. 
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Forum subscriptions 

You may also manage forum subscriptions. 

When subscribed to a forum, you will receive an email message in your University / JC mailbox each time 
somebody posts a message or a reply. This makes it easy to keep track of what’s happening in the forums 
without constantly logging in. By default, such email messages are sent 30-45 minutes after the post is 
made in a forum. 

To subscribe to a forum you are currently viewing, click the Subscribe to forum button. If this button is 
not available, it means that your tutor either set forced subscription for everyone, or disabled 
subscription for that particular forum activity. 

 

 
Subscribe to individual discussions 

In a forum with Optional or Auto subscription, you can also choose which discussions to subscribe to. It 
is not necessary to receive emails for all threads within a particular forum. To subscribe to a particular 

discussion, click the toggle icon  available under the Subscribe heading. When the toggle icon is red 

, it indicates that you are subscribed. To unsubscribe from a particular discussion, click the toggle 
button. 

 

 
Enabling email digests 

By default, the VLE will send an email message for every forum post you’re subscribed to. Although 
preferred by some users, others might get overwhelmed by all the messages cluttering their mailbox, 
especially if subscribed to multiple forums. 

For this reason, you may enable email digests for your profile, so that the VLE only sends one email a 
day. This email, which is typically received after 1700hrs (Central European Time), will include all the 
new posts made throughout the past 24hrs in forums you are subscribed to in all your VLE areas. 
 
To enable / change the email digests: 

1. Click your User menu (top-right corner). 

2. Select Preferences. The Preferences page will be displayed. 

3. Click the Forum preferences link. 

4. From the Email digest type, select your preferred option. 

5. Click the Save changes button. 
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Announcements forum 

The Announcements forum is a special forum for general 
announcements. This forum is automatically created for each VLE area 
and, by default, it is placed in the top of the contents section. 

Only your tutors may add posts or reply to posts in the Announcements forum. All participants in a VLE 
area are subscribed to the Announcements forum, thus, all will receive an email message in their 
University / JC mailbox. 
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